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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON printer. EPSON is not responsible for any use of this information as applied to other 
printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original EPSON Products or EPSON 
Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted Materials

Ink jet printers, digital cameras, and scanners, like photocopiers and conventional cameras, can be misused by 
improper copying and reprinting of copyrighted material. While some countries’ laws permit limited copying of 
copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. 
EPSON encourages each user to be responsible and respectful of the copyright laws when using ink jet printers, 
digital cameras, and scanners.

Trademarks
EPSON, EPSON Stylus, EPSON Photo Stickers, and MicroWeave are registered trademarks and PRINT Image 
Matching is a trademark of SEIKO EPSON CORPORATION.

ColorLife, BorderFree, PhotoEnhance, and EPSON Software are trademarks, and EPSON Print Lab, EPSON 
PhotoCenter, EPSON Store, and SoundAdvice are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

 Printed on recycled paper CPD-15861R1
Copyright © 2003 by Epson America, Inc.  4/03
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Welcome!

Your EPSON Stylus® Photo 900 is a full-featured photo and CD/DVD printer. 
Outstanding printouts result from these advanced features:

■ EPSON’s 6-color photo inks let you print up to 5760 × 720 optimized dpi
(dots per inch)

■ Ultra fine 4-picoliter ink droplets give you finer shadow detail, dazzling 
highlights, and better fill across a wider range of colors

■ Direct CD/DVD printing lets you create customized “labels”—with your own 
photos, text, and artwork—for all the CDs you burn

■ True BorderFree™ frame-ready prints on select 4 × 6, 5 × 7, 8 × 10, and letter-size 
papers

■ Roll paper feeder enables continuous printing of multiple photos

■ Straight-through paper path for thick paper gives you more media choices than 
ever before
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About Your Software

Your printer CD-ROM includes all the software you need for printing. See the 
Start Here sheet for installation instructions.

■ Your printer driver runs your printer and lets you control how your documents 
look. You can’t print without it. 

Tip: It’s a good idea to check EPSON’s support website periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

■ Your EPSON Printer Information Center gives you quick, on-screen access to 
information about your printer. It includes EPSON Print Show animated 
tutorials on loading roll paper, loading CDs and DVDs, replacing ink cartridges, 
and other tasks. It also includes an on-screen User’s Guide for complete 
information about your printer.

■ Your photo software includes these great tools:

EPSON Software™ Film Factory™ is a photo management program that lets you 
organize, beautify, and print your photos in a flash. Supports PRINT Image 
Matching™ (P.I.M. I and II) and Exif Print. (P.I.M. support not available for 
Mac® OS X.)

P.I.M. II Plug-in for Adobe® Photoshop® lets you retain PRINT Image 
Matching image quality when you import JPEG files from your PIM-enabled 
digital camera. (Compatible with Photoshop 6.0, 7.0, and Photoshop Elements 
1.0 and 2.0.)

EPSON PhotoCenter  is EPSON’s free photo-sharing website where you can 
store, organize, and share your photos; print high-resolution photos; and create 
free online postcards. Add a link to EPSON PhotoCenter on your desktop with 
your software installer.

■ EPSON Print CD lets you print directly on CDs and DVDs. Add your own text, 
photos, and graphics for professional-looking results. Works with all ink jet 
printable CDs and DVDs. (EPSON Print CD not available for Mac OS X.)

SM
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About Your Documentation

To set up your printer and install its software, see the Start Here sheet. 

This book contains system requirements, important safety information, your 
warranty, and instructions on:

■ Using the EPSON Printer Information Center

■ Loading all types of paper

■ Printing with Windows or on a Macintosh

■ Printing on CDs and special media

■ Maintaining your printer

■ Solving basic problems

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain hints for better printing.

For more details about your printer, see your Print Show animated tutorials and 
User’s Guide, as described on page 10.
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Using the EPSON Printer Information 
Center

Need help loading paper, loading CDs or DVDs, or changing an ink cartridge? Use 
the EPSON Printer Information Center (EPIC) to view printer animations that 
quickly show you how. EPIC also includes an on-screen User’s Guide with additional 
printer details. Follow the instructions on the Start Here sheet to install the EPSON 
Printer Information Center, if you haven’t already.

Note: You need a browser—such as Microsoft® Internet Explorer® 4.0 or later or 
Netscape® Navigator® 3.0 or later—to view the manual. If you are using a 
different browser, the pages may not display correctly.

Launching the Animations

1. Double-click the EPSON Printer Information Center icon on your desktop.

2. Click Print Show.

Click Print Show
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3. Click a title.

Use the program tools to pause a movie, replay a step, or skip ahead.

4. Click Exit to exit EPSON Print Show.

Launching the Manual

1. Double-click the EPSON Printer Information Center icon on your desktop.

2. Click User’s Guide. You see this screen:

3. Click on the topic you want to view.

Click a topic to 
view a movie

Click a topic
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Loading Paper

You can load a variety of paper types in your printer, as described in these sections:

■ “Loading Single Sheets” below

■ “Loading Roll Paper” on page 14

■ “Loading Envelopes” on page 17

■ “Loading Special Papers” on page 19

For information about loading paper in the manual feed slot see “Printing on CDs 
and Special Media” on page 47.

Loading Single Sheets

1. Insert your paper against the right edge of the sheet feeder.

2. Slide the left edge guide against the paper (but not too tightly).

3. Open the output tray and its extension.

Insert paper against 
the right edge

Slide the left edge 
guide against the paper
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Also be sure to:

■ Load the printable side face-up. It’s often whiter or brighter than the other side.

■ Load letterhead or preprinted paper into the printer top edge first.

■ Don’t load paper above the arrow on the left edge guide.

■ Load up to approximately 100 sheets of plain paper at time.

Loading Roll Paper

You can load the following types and sizes of roll paper:

1. Remove the tape and protective paper from the end of the roll. Then insert the 
holders into the roll of paper as shown.

2. Make sure the end of the paper is cut straight across, with 90° corners. If the end 
is cut diagonally, you may have problems feeding the paper.

Paper name Roll sizes

EPSON Premium Glossy Photo Paper 4 inches × 26 feet
8.3 inches (A4) × 32.8 feet

EPSON Premium Semigloss Photo Paper 4 inches × 26 feet

EPSON Premium Luster Photo Paper 8.3 inches (A4) × 32.8 feet
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3. If the paper curls at the end, fold a sheet of paper over the end and roll it 
backward to uncurl it.

Avoid touching the printable surface of the roll paper.

4. Remove any paper that’s in the sheet feeder at the top of the printer. Then remove 
the paper support, lower the output tray, and turn on the printer.

5. Make sure the paper thickness lever is set to the  position.
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6. Install the roll paper holders on the printer. Insert the left holder into the far left 
slot, then insert the other holder into the appropriate slot on the right (either the 
4-inch slot as shown, or the 8.3-inch slot further on the right).

7. Pull out approximately six inches of paper and insert it into the sheet feeder. Then 
slide the left edge guide against the paper (but not too tightly).

8. Hold the paper in place by the edges and press the  roll paper button until the 
printer feeds the paper automatically.

9. To verify that the paper is loaded straight, open the printer cover and look into 
the printer.
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If the paper is crooked, press the  roll paper button and hold it for three 
seconds to back the paper all the way out.

Then turn the roll paper holder knobs to roll up the paper. Press the  roll paper 
button to clear the paper out error. Repeat steps 7 through 9 to reload the paper.

Loading Envelopes

1. Open the output tray and its extension.

2. Load up to 10 envelopes at a time, flap edge left, printable side up, against the 
right edge of the sheet feeder.

3. Slide the left edge guide against the envelopes (but not too tightly).
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4. Set the paper thickness lever to the  position (remember to set it back to the 
position when you’re done).

Note: For best results, press each envelope flat before loading, or load one 
envelope at a time.

Select the following settings when printing on envelopes:

■ Plain paper as the Type or Media Type setting

■ The correct envelope size as the Size (Windows) or Paper Size (Macintosh) setting

■ Landscape as the Orientation setting

For instructions on selecting these settings, see: 

■ “Printing in Windows” on page 21

■ “Printing with Macintosh OS 8.6 to 9.x” on page 32

■ “Printing with Macintosh OS X” on page 35
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Loading Special Papers

To load EPSON ink jet papers, follow these guidelines:

■ Load all paper with the printable side up. It’s usually whiter or brighter than the 
other side.

■ If the paper has a cut corner, position it in the upper right corner as you load it in 
the sheet feeder.

■ Check the paper package for additional instructions on using special papers.

Paper type Loading capacity

Premium Bright White Paper 100 sheets

Photo Quality Ink Jet Paper 65 sheets

Photo Quality Ink Jet Cards 30 cards with a support sheet beneath the stack

Glossy Photo Paper or Photo Paper 20 sheets

Panoramic Photo Paper 1 sheet with a support sheet beneath the sheet

Matte Paper Heavyweight

Double-Sided Matte Paper

20 sheets with a support sheet beneath the 
stack

ColorLife Photo Paper 1 sheet with a support sheet beneath the sheet

Double-Sided Matte Paper

Premium Glossy Photo Paper

Premium Semigloss Photo Paper

Premium Luster Photo Paper

Ink Jet Transparencies

Iron-On Transfer Paper

Photo Stickers

Photo Quality Self Adhesive Sheets

Glossy Photo Greeting Cards

1 sheet



20 Loading Paper

Storing Your Photos

With proper care, photographs from your EPSON Stylus Photo printer will last for 
many years. The special EPSON inks designed for your printer are formulated to 
achieve improved lightfastness when used with EPSON papers for prints that are 
properly displayed or stored.

Tip: For best results, always use EPSON papers.

As with traditional photos, proper care will minimize color changes and lengthen 
display life:

■ For display, EPSON recommends that prints be framed under glass or a 
protective plastic sleeve to protect them from atmospheric contaminants like 
humidity, cigarette smoke, and high levels of ozone.

■ As with all photographs, keep your prints away from direct sunlight.

■ For proper storage, EPSON recommends that you keep your prints in a photo 
album or plastic photo storage box in acid free, archival sleeves commonly 
available from most camera stores.

Note: Always keep unused paper in the original package. 

To order EPSON paper, contact your dealer or call the EPSON Store  at 
(800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada please call 
(800) 463-7766 for dealer referral.

SM
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Printing in Windows

Before you start, make sure your printer is set up and its software is installed as 
described on the Start Here sheet.

Whenever you print, make sure you do the following:

■ Use the right paper.
For the best-looking photos, most vivid colors, and greatest detail, always use 
genuine EPSON papers and EPSON inks.

■ Choose the right printer settings.
Your printer automatically adjusts itself for each type of paper. That’s why printer 
settings are important. They tell your printer what kind of paper you’re using and 
what type of print you want. Make sure you check your printer settings every time 
you print.

See these sections for instructions on selecting printer settings:

■ “Printing From an Application” on page 22

■ “Selecting Default Settings” on page 24
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Printing From an Application

After you create a document in a software program, follow these steps to print it using 
the basic printer settings:

1. From the file menu, click Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo 900 is selected.

3. Click the Preferences or Properties button. (If you see a Setup, Printer, or 
Options button, click it. Then click Preferences or Properties on the next 
screen.)

Select your printer name here

Click here to open 
your printer software
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4. Select the following in the properties window:

5. Select from these Quality Types:

Draft: for rough drafts with reduced print quality

Text: For text-only documents with higher text quality

Text & Image: For documents with text and images with higher quality

Photo: For photos and graphics with good quality and speed

Best Photo: For photos or graphics with high print quality

Note: The Quality Type settings on this screen give you the best combination of 
quality and speed for most prints. For the highest quality (Photo RPM) on 
selected papers, click the Advanced button on the Main tab. Then see 
“Customizing Windows Print Settings” on page 25 for instructions on selecting 
Photo RPM.

6. Select the paper Type for the paper you’ve loaded. See “Selecting the Correct 
Paper Type” on page 27 for more information about paper types.

7. Select other settings as shown above.

Tip: For more information about printer settings, click the ? or Help button.

Select the type of document you’re printing

Select your paper 
Type

Select your paper 
Size

Select your 
document or 
image orientation
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8. Click OK.

9. At the Print window, click OK or Print to start printing.

During printing, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or resume printing. You can also see how much 
ink you have left.

Selecting Default Settings

Your printer settings only apply to the program you’re currently using. If you want, 
you can change the Windows default printer settings for all your programs.

1. Right click the  printer icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the window shown in “Printing From an 
Application” on page 22.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.

Click to cancel printing

Click to pause or resume printing
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Customizing Windows Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

1. On the Main tab, click the Advanced button in the bottom right corner of the 
window.

2. If you see a warning note, click Continue.

3. Select the following advanced settings as necessary:

Note: For the highest print quality, select Photo RPM. Please note that printing 
will take longer in this mode. 

For more information about advanced settings, or instructions on saving them as 
a group so you can reuse them later, click the ? or Help button. If you want to use 
the Advanced screen each time you access your printer settings, select the 
Show this screen first checkbox.

Select a color 
management 
method

(To choose 
No Color 
Adjustment, 
click ICM 
first)

Select Paper & Quality 
Options as necessary

Click here to select 
Photo RPM (5760 × 
720) for the best print 
quality on photo and 
glossy paper types

Select Print Options 
as necessary
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4. Once you’ve finished selecting advanced settings, you can:

■ Click OK to save your settings, return to the Print dialog box, and print.

■ Click the Basic button to return to the Basic settings.

■ Click the Page Layout tab and continue with step 5 to select layout options.

5. Select the following page layout settings as necessary:

Note: For more information on page layout settings, click the ? or Help button.

6. Click OK to save your settings, then click OK or Print.

Select multi-page 
document options 
here and hereSelect image resizing 

options here; these 
affect only your 
printed image

Select image 
position options 
here

Add a watermark to 
printed page here
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Selecting the Correct Paper Type

Select the correct paper Type setting so your printer knows what kind of paper you’re 
using and adjusts the ink coverage accordingly.

For this paper Select this paper Type setting

Plain paper sheets or envelopes

EPSON Premium Bright White Paper

Plain paper

EPSON Iron-On Transfer Paper 360 dpi Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Matte Paper Heavyweight

EPSON Double-Sided Matte Paper

Matte Paper - Heavyweight

EPSON Photo Paper

EPSON Panoramic Photo Paper

Photo Paper

EPSON Glossy Photo Paper

EPSON All Purpose Glossy Paper

EPSON Photo Quality Glossy Paper

EPSON Glossy Photo Greeting Cards

Glossy Photo Paper

EPSON Premium Glossy Photo Paper 
(including roll paper)

Premium Glossy Photo Paper

EPSON Premium Luster Photo Paper Premium Luster Photo Paper

EPSON Premium Semigloss Photo Paper Premium Semigloss Photo Paper

EPSON Photo Stickers® Photo Quality Glossy Film

EPSON ColorLife™ Photo Paper ColorLife Photo Paper

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Printing Borderless Photos on Cut Sheets

You can print your photos with no margins, extending the image all the way to the 
edges of the page.

Note: For instructions on printing borderless photos on roll paper, see “Loading 
Roll Paper” on page 14.

Although borderless printing is a bit slower, you get beautiful snapshots and 
enlargements, without trimming, on these papers and sizes:

Follow these steps to print borderless photos:

1. Start your photo program and open your photo.

2. Open the File menu and click Print. Then click Properties or Preferences. 

Paper name Sizes

Paper type or Media Type 

setting

EPSON Matte Paper 
Heavyweight

8 × 10
Letter (8.5 × 11 inches)

Matte Paper - Heavyweight

EPSON Glossy Photo 
Paper

Letter (8.5 × 11 inches) Glossy Photo Paper

EPSON Photo Paper Letter (8.5 × 11 inches) Photo Paper

EPSON Premium 
Glossy Photo Paper

4 × 6 
5 × 7
8 × 10
Letter (8.5 × 11 inches)

Premium Glossy Photo 
Paper

EPSON Premium 
Semigloss Photo Paper

Letter (8.5 × 11 inches) Premium Glossy Photo 
Paper

EPSON Premium Luster 
Photo Paper

Letter (8.5 × 11 inches) Premium Luster Photo Paper
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You see the following screen:

3. Select Photo or Best Photo as the Quality Type setting.

4. Choose Sheet as the paper Source setting.

5. Select one of the following paper types:

■ Matte Paper Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Premium Glossy Photo Paper

■ Premium Luster Photo Paper

■ Premium Semigloss Photo Paper

6. Click the Borderless checkbox. Read the message and click OK.

7. Select your paper Size setting

8. Select Portrait or Landscape as the orientation setting.

Click OK, then click OK or Print.

Select the type of document you’re printing

Select your paper 
Type

Select your paper 
Size

Select your 
document or 
image orientation
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Printing on a Macintosh

Before you start, make sure your printer is set up and its software is installed as 
described on the Start Here sheet.

Whenever you print, make sure you do the following:

■ Use the right paper.
For the best-looking photos, most vivid colors, and greatest detail, always use 
genuine EPSON papers and EPSON inks.

■ Choose the right printer settings.
Your printer automatically adjusts itself for each type of paper. That’s why printer 
settings are important. They tell your printer what kind of paper you’re using and 
what type of print you want. Make sure you check your printer settings every time 
you print.

See these sections for instructions on selecting printer settings:

■ “Printing with Macintosh OS 8.6 to 9.x” on page 32

■ “Printing with Macintosh OS X” on page 35
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Printing with Macintosh OS 8.6 to 9.x

Before you begin make sure you selected your printer in the Chooser as described in 
“Installing Your Printer Driver” on page 87.

1. From the File menu, select Page Setup. Select the following settings:

2. Click OK to close the Page Setup window.

3. From the File menu, select Print. You see a window like this one:

Make sure you see SP 900

Select your paper size

Select your paper source

Select your document 
or image orientation

Select the type of 
paper you’re using

Select Color or 
Black Ink

Select higher quality or faster printingSelect Automatic mode
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4. Select the following settings:

■ Choose your paper from the Media Type list. See “Selecting the Correct 
Media Type” on page 42 for details.

■ Select Color to print a color document or black and white photograph. To 
print a black text document, click Black.

■ Choose Automatic to get good printing results for most projects.

■ Set the slider to Quality to select high-quality printing, or Speed for faster 
printing. (The slider is not available for all paper types.)

Note: The Quality setting on this screen gives you the best combination of quality 
and print speed for most prints. For the highest print quality (Photo RPM) on 
selected papers, click Custom then click the Advanced button and see 
“Customizing Macintosh Print Settings” on page 38 for instructions on selecting 
Photo RPM.

5. You can also do the following:

■ Click  to reduce/enlarge your printed image, print multi-page layouts, or 
add a watermark.

■ Click  to control background printing and schedule print jobs.

■ Click , then click Preview to preview your printout.

■ Click  to check your ink levels.

Tip: For more information about printer settings, click the ? button.

6. Click Print.
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7. If you turned on background printing, you can select EPSON Monitor IV from 
the Application menu in the upper right corner of your screen. You see the 
EPSON Monitor window:

Note: If you’re not using background printing and you need to cancel printing, 
hold down the  key and press the . (period) key.

Click to check 
ink levels

Select your print job, 
then click here to 
cancel printing

Click here to show 
or hide the print 
settings
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Printing with Macintosh OS X

If you’re using an OS X compatible printing application, follow the steps below to 
print a document. (If you’re using an application that’s compatible only with 
Macintosh Classic mode, follow the steps in “Printing with Macintosh OS 8.6 to 9.x” 
on page 32 instead.)

Before you begin, make sure you added your printer to the Print Center as described 
on the Start Here sheet.

1. From the File menu, select Page Setup. Select the following settings:

2. Select your printer from the Format for drop-down list.

Tip: To print with minimized margins feature, select Stylus Photo 900 
(Standard - Minimize Margins) from the Format for list. Make sure you choose 
the same option as the printer setting in the Print window.

Caution: When printing non-borderless print jobs using a custom page size, 
make sure the selected size matches the paper you loaded and is within the 
printable area for your printer. For example, never choose a size wider than 9 
inches or longer than 44 inches.

3. Click OK to close the Page Setup window.

Select your printer 
name from the list

Select your paper size

Select your document 
or image orientation



36 Printing on a Macintosh

4. From the File menu select Print. You see a window like this one:

5. Select your printer name from the Printer drop-down list. 

Note: Make sure you chose the same printer that you selected in step 2.

6. Select Print Settings from the list.

7. Select the following Print Settings as necessary:

Note: For more information about printer settings, click the Help button.

The Quality setting on this screen gives you the best combination of quality and 
print speed for most prints. For the highest print quality (Photo RPM) on selected 
papers, click Custom, then click the Advanced button and see “Customizing 
Macintosh Print Settings” on page 38.

Select Print Settings 
from the list

Select the same 
printer name you 
chose in step 2.

Select the type of 
paper you’re using

Select Color or 
Black Ink

Select higher 
quality or faster 
printing (if available)

Select Automatic 
mode
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8. You can also choose other print settings by selecting these options in the 
pull-down menu:

■ Copies & Pages, to select the number of copies or a page range

■ Layout, to select page layout options

■ Output Options, to save your print job as a PDF file

■ Color Management, to select ColorSync,® adjust the color controls, change 
the gamma setting, or turn off color adjustments in the printer software

■ Summary, to view a list of all your selections

■ Save Custom Setting (OS X 10.1.x only), to save your selections for future 
use (OS X 10.2.x, select Save As from the Presets pull-down menu instead)

9. Click Print.

10. To monitor the progress of your print job, click the  Print Center icon when 
it appears in the dock on the bottom of your desktop.

With OS X 10.2.x, double-click Stylus Photo 900 in the Printer List window.

You see a screen like this:

11. Monitor the progress of your print job or do one of the following:

■ Click the print job, then click Delete to delete the job

■ Click the print job, then click Hold to pause printing

■ Click a print job marked “Hold” and click Resume to resume printing

12. When you’re finished, close Print Center.
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Customizing Macintosh Print Settings

Macintosh OS 8.6 to 9.x

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

1. On the printer settings window, click Custom, then click the Custom Settings 
list to open it.

Note: For more information on custom settings, click the ? button.

2. If you’re finished selecting custom settings, click Print to print your document.

To select more custom settings, go to step 3.

3. To access advanced settings click Custom, then click Advanced.

Click Custom, then choose: 
Economy (to save ink on plain paper) or 
ColorSync (to match printed colors with 
compatible device colors) from the Custom 
Settings list
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4. Select these advanced settings as necessary:

Note: For the highest print quality, select Photo RPM. Please note that printing 
will take longer in this mode.

For more information on advanced settings, or instructions on saving them as a 
group so you can reuse them later, click the ? button.

5. Click OK to save your settings, then click Print.

Click here to select Photo 
RPM (5760 × 720) for the 
best print quality on certain 
paper types

Select various print 
options here

Select color management 
settings here
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Macintosh OS X

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

1. On the printer settings window, click Custom, then click the Custom Settings 
list to open it.

2. If you’re finished selecting custom settings, click Print to print your document.

To select more custom settings, go to step 3.

3. To access advanced settings, click Advanced Settings.

Click Custom, then choose:

Economy (to save ink on plain paper) or 
ColorSync (to match printed colors 
with compatible device colors)
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4. Select these advanced settings as necessary:

Note: For the highest print quality, select Photo RPM. Please note that printing 
will take longer in this mode.

For more information on advanced settings, or instructions on saving them as a 
group so you can reuse them later, click Help.

5. Click Print.

Click here to select Photo RPM 
(5760 × 720) for the best print 
quality on certain paper types

Select various print options here

To select color management 
settings, select Color Management 
from the Print Settings pull-down 
menu
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Selecting the Correct Media Type

Select the correct Media Type setting so your printer knows what kind of paper 
you’re using and adjusts the ink coverage accordingly.

For this paper Select this Media Type setting

Plain paper sheets or envelopes

EPSON Premium Bright White Paper

Plain paper

EPSON Iron-On Transfer Paper 360 dpi Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Matte Paper Heavyweight

EPSON Double-Sided Matte Paper

Matte Paper - Heavyweight

EPSON Photo Paper

EPSON Panoramic Photo Paper

Photo Paper

EPSON Glossy Photo Paper

EPSON Photo Quality Glossy Paper

EPSON Glossy Photo Greeting Cards

Glossy Photo Paper

EPSON Premium Glossy Photo Paper Premium Glossy Photo Paper

EPSON Premium Luster Photo Paper Premium Luster Photo Paper

EPSON Premium Semigloss Photo Paper Premium Semigloss Photo Paper

EPSON Photo Stickers Photo Quality Glossy Film

EPSON ColorLife Photo Paper ColorLife Photo Paper

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Printing Borderless Photos on Cut Sheets

You can print your photos with no margins, extending the image all the way to the 
edges of the page.

Note: For instructions on printing borderless photos on roll paper, see “Loading 
Roll Paper” on page 14.

Although borderless printing is a bit slower, you get beautiful snapshots and 
enlargements, without trimming, on these papers and sizes:

See these sections for instructions on selecting printer settings:

■ “Macintosh OS 8.6 to 9.x” on page 44

■ “Macintosh OS X” on page 45

Paper name Sizes

Paper type or Media Type 

setting

EPSON Matte Paper 
Heavyweight

8 × 10
Letter (8.5 × 11 inches)

Matte Paper - Heavyweight

EPSON Glossy Photo 
Paper

Letter (8.5 × 11 inches) Glossy Photo Paper

EPSON Photo Paper Letter (8.5 × 11 inches) Photo Paper

EPSON Premium 
Glossy Photo Paper

4 × 6 
5 × 7
8 × 10
Letter (8.5 × 11 inches)

Premium Glossy Photo 
Paper

EPSON Premium 
Semigloss Photo Paper

Letter (8.5 × 11 inches) Premium Glossy Photo 
Paper

EPSON Premium Luster 
Photo Paper

Letter (8.5 × 11 inches) Premium Luster Photo Paper
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Macintosh OS 8.6 to 9.x

1. Start your photo program and open your photo file.

2. Open the File menu and click Page Setup. You see the following:

3. Select your Paper Size.

4. Choose Auto Sheet Feeder as the Paper Source.

5. Click the Borderless checkbox. Read the message and click OK.

6. Select Portrait or Landscape as the orientation setting.

7. When you have finished making page setup settings, click OK.

8. Open the File menu and click Print.

9. Select one of the following Media Types:

■ Matte Paper - Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Premium Glossy Photo Paper

■ Premium Luster Photo Paper

■ Premium Semigloss Photo Paper

10. Select Quality (for higher quality) or Speed (for faster printing) using the slider.

11. Click Print.
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Macintosh OS X

1. Start your photo program and open your photo file.

2. Open the File menu and click Page Setup. You see the following:

3. Select Stylus Photo 900(Sheet Feeder - Borderless) in the Format for 
drop-down list.

Caution: When printing borderless photos, select one of the supported paper 
sizes listed in the table on page 43; never select a custom or unsupported paper 
size or ink may spray inside your printer.

4. Select your Paper Size.

5. Select your document or image orientation.

6. Click OK.

Select Stylus Photo 900(Sheet 
Feeder - Borderless)
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7. Open the File menu and click Print. You see the following:

8. Select Stylus Photo 900(Sheet Feeder - Borderless) in the Printer drop-down 
list.

Note: Make sure you chose the same printer that you selected in step 3.

9. Select Print Settings from the list.

10. Select one of the following Media Types:

■ Matte Paper Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Premium Glossy Photo Paper

■ Premium Luster Photo Paper

■ Premium Semigloss Photo Paper

11. Select Quality (for higher quality) or Speed (for faster printing) using the slider. 

12. Click Print.

Select Stylus Photo 900(Sheet 
Feeder - Borderless)
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Printing on CDs and Special Media

Your EPSON Stylus Photo 900 gives you several options for specialized printing:

■ You can print directly on ink-jet printable CDs and DVDs using your own 
photos, text, and artwork.

■ You can print a series of photos on roll paper.

■ You can use the manual feed slot to print on heavy materials such as card stock 
and matte board up to 1.3 mm thick.

Follow the instructions in these sections:

■ “Printing on CDs and DVDs” below

■ “Printing on Roll Paper” on page 61

■ “Printing on Card Stock or Matte Board” on page 69

Printing on CDs and DVDs

Your printer includes a special tray that lets you print customized text, graphics, and 
photos directly on any ink-jet printable CD or DVD. The EPSON Print CD 
software makes it easy to import your own photos, add text, and modify your designs 
with a variety of special effects. You can print on both regular 12-cm CDs and 8-cm 
mini CDs.

Caution: Thermal printable CDs and DVDs should not be used with this printer.

You can order ink-jet printable CDs and DVDs from several websites, for example, 
www.pcmall.com, www.cdw.com, www.warehouse.com, www.zones.com, 
www.macconnection.com, and www.pcconnection.com. Make sure you purchase 
CDs and DVDs that have an ink-jet printable surface.
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Follow the steps in these sections:

■ “Cleaning the Roller” on page 48

■ “Designing CDs and DVDs” on page 49

■ “Inserting a CD or DVD” on page 53

■ “Printing Your Design” on page 56

■ “Adjusting the Print Position” on page 57

■ “Adjusting the Print Density” on page 59

Cleaning the Roller

Before you print on CDs or DVDs, it’s a good idea to clean the roller inside the 
printer. You can do this by feeding and ejecting several sheets of plain paper. 

1. Make sure the printer is turned on and letter-size paper is loaded.

2. Press the  paper button to feed the paper into the printer.

3. Press the  paper button again to eject the paper.

4. Repeat steps 2 and 3 several times.
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Designing CDs and DVDs

You can use EPSON Print CD to create and print a design with images, graphics, and 
text. You can use your own photos or choose from a selection of photographic and 
abstract images included with the program. 

Note: EPSON Print CD software is not available for Mac OS X.

The easiest way to create your own design is to start with an existing file and then 
personalize it for your own use.

1. Start EPSON Print CD.

2. Click the  Open icon or select Open from the File menu.

3. Select Sample1.ec2 and click OK (Windows), or sample01 and click Open 
(Macintosh). 

You see the Midnight Music CD on the workspace:

Windows Macintosh
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4. To change the background image, click the  Background icon (Windows) or 
choose Background from the Insert menu (Macintosh). You see a window like 
the following:

5. Click Select Image (Windows) or Select Background (Macintosh).

You see the following:

6. Select one of the images included with the program, and click OK (Windows) or 
Open (Macintosh). (You can also click the TWAIN button to scan in an image or 
download one from your digital camera.)

Windows

Macintosh

Click here to 
select a new 
background image

Windows

Macintosh
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If you want to choose one of your own images, do one of the following:

■ Windows: Click the File tab, then click Browse to locate the folder where 
your images are stored and click OK. You see thumbnail images of all the files 
in the folder. Select your image and click OK. 

■ Macintosh: Locate the folder where your images are stored, then select the 
one you want and click Open.

7. If you want to modify the template or enhance your image, click Image 
Adjustment (Windows), or use any of the available editing features (Macintosh). 
You can adjust the brightness, contrast, and gamma, or apply mosaic, blur, or 
special color effects. 

Windows

Macintosh
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8. To edit the text, do one of the following:

■ Windows: Double-click any text block on the CD image to open the text 
editing window. Enter your text and use the tabs to apply formatting and 
special effects, then click OK.

■ Macintosh: Use any of the options on the Text Settings palette. You can also 
use the options on the Color Settings and Object Settings palettes.

9. To curve a single line of text, click the text, then drag the red “handle” up or 
down. 

10. When you’re finished, choose Save as from the File menu to save your file. 

Note: To check your design, it’s a good idea to print it on a sheet of plain paper 
before printing on a CD or DVD. Make sure you have plain paper loaded in the 
printer, then follow the instructions in “Printing Your Design” on page 56 to print.

When you’re ready to load a CD or DVD, follow the instructions in “Inserting a CD 
or DVD” on page 53.

Windows

Macintosh

Click here to curve 
a line of text
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Inserting a CD or DVD

Make sure the data, music, or video is burned on your ink-jet printable CDs or DVDs 
before you print. Otherwise, dirt or scratches on the surface may cause errors when 
you burn the data. If you plan to print large numbers of CDs or DVDs, it’s a good 
idea to print a small sample, then wait a day and check the quality to make sure it is 
satisfactory. 

If you want to check the print position or color, see the instructions for “Adjusting the 
Print Position” on page 57 and “Adjusting the Print Density” on page 59.

Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, the 
disc may not be positioned correctly. 

Then follow these steps:

1. Push in the output tray extension, but leave the tray open.

2. Set the paper thickness lever to the  position. The  paper light begins flashing 
rapidly.
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3. Place the CD or DVD on the CD tray with the white or printable side face-up.

4. Slide the edge guide to the right to make room for the tray.
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5. Insert the tray against the left side of the feeder.

6. Open the printer cover and push the tray into the printer, aligning the white line 
on the tray with the edges of the printer rollers.

7. Slide the edge guide against the tray.

White line

Printer rollers
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8. Set the paper thickness lever to the  position. The  paper light goes out.

9. Close the printer cover. Then follow the instructions in “Printing Your Design” 
below to print with EPSON Print CD.

Printing Your Design

After you have created your design and loaded a CD or DVD, you’re ready to print.

1. Open the File menu and select Printer Settings (Windows) or Page Setup 
(Macintosh).

2. Make sure your EPSON Stylus Photo 900 is selected, and the Paper Source is set 
to Manual or Manual Feed.

Macintosh
Windows

Select the Manual or Manual Feed paper source
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3. Click OK.

4. Open the File menu and select Print, or click the  Print button. You see this 
screen:

5. Click OK (Windows) or Print (Macintosh).

Note: After you print, handle the CD or DVD carefully. To allow the ink to dry fully, 
wait at least 24 hours before playing the disc or inserting it in a drive. Keep 
printed discs away from moisture and direct sunlight.

When you’re finished printing on CDs and DVDs, make sure you return the paper 
thickness lever to the  position.

Caution: Don’t move the paper thickness lever during printing; this could damage 
your printer.

If you want to check the print position or color, see the instructions for “Adjusting the 
Print Position” on page 57 and “Adjusting the Print Density” on page 59.

Adjusting the Print Position

If your printed images and text are not centered or positioned the way you want, you 
may need to adjust the printing position. Use the blank cardboard check disk 
included with your printer, or an extra CD. You can also use these steps to check the 
position before you print on a CD or DVD:

1. Place the position check disk (or an extra CD) on the CD tray and insert it into 
the printer, as described on page 53.

2. Start EPSON Print CD.

MacintoshWindows
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3. Follow the instructions in “Printing Your Design” on page 56 to make sure your 
EPSON Stylus Photo 900 is selected, and the Paper Source is set to Manual or 
Manual Feed.

4. Select Print from the File menu, or click the  Print button. You see this screen:

5. Select Print Position Confirmation (or Check) Pattern and click OK 
(Windows) or Print (Macintosh). The confirmation pattern is printed on the 
check disk or CD.

6. Remove the check disk or CD and measure the distance from the edge of the hole 
to the small cross marks (distances labeled A and B as shown). You’ll need a 
millimeter ruler for these measurements.

MacintoshWindows

Select this setting
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7. Open the File menu and select Adjust Print Position. You see this screen:

8. Make sure Enter Values or Value Entry is checked, then input the A distance in 
the Height (Top) or Top Space box. Enter the B distance in the Width (Right) 
or Right Space box.

9. Click OK to save the measurements to the EPSON Print CD program.

Adjusting the Print Density

If ink smears on your printed CDs or DVDs, you may need to adjust the color 
saturation or ink density. CDs from different manufacturers may absorb ink 
differently, so you may need to adjust the density for each type of disc. Follow these 
instructions to print a color saturation check pattern, and then make adjustments as 
necessary.

1. Insert a test CD or DVD for printing, as described on page 53.

2. Start EPSON Print CD.

3. Follow the instructions in “Printing Your Design” on page 56 to make sure your 
EPSON Stylus Photo 900 is selected, and the Paper Source is set to Manual or 
Manual Feed.

MacintoshWindows

Enter measurements here
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4. Select Print from the File menu, or click the  Print button. You see this screen:

5. Select Print Density Confirmation (or Check) Pattern and click OK 
(Windows) or Print (Macintosh).

6. After the pattern is printed, examine the printed CD or DVD and make the Print 
Color Correction (or Color Correction) setting lighter or darker as necessary.

You can print three density patterns on one disc. Each pattern is printed in a 
different location.

After the first pattern is printed, adjust the setting, then repeat steps 4 through 6, 
selecting Second or Second Time to print the second pattern. 

If you want to try a third Color Correction setting, you can repeat steps 4 through 
6 again and select Third or Third Time.

7. Remove the CD or DVD and let it dry for at least 24 hours. Then check the 
saturation levels again.

Note: You can also use the Brightness and Contrast settings in EPSON Print CD 
to adjust color saturation. See “Designing CDs and DVDs” on page 49 for 
instructions.

MacintoshWindows

Select this setting
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Printing on Roll Paper

Before you print on roll paper, make sure the paper is loaded correctly, as described in 
“Loading Roll Paper” on page 14. Follow the steps in the next sections to select your 
roll paper settings in Windows or Macintosh.

■ “Windows” below

■ “Macintosh OS 8.6 to 9.x” on page 63

■ “Macintosh OS X” on page 64

■ “Removing Your Photos and Paper” on page 67

Windows

1. Open your photo file and resize it as necessary.

2. Open the File menu and click Print. 

3. Click Properties or Preferences. You see this screen:

4. Choose Photo or Best Photo as the Quality Type.



62 Printing on CDs and Special Media

5. Choose Roll as the paper Source. The Roll Paper Options window pops up, as 
shown above.

6. Select one of the following Roll Paper Options:

■ Banner Mode: Makes multi-page documents print as one large page. When 
the Save roll paper option is checked, the printer stops printing after the last 
word or image is printed.

■ Cut Sheet Mode: Prints multi-page documents as individual pages. When 
the Print page frame option is checked, the printer prints a dashed line 
between each page.

7. Click Borderless if you want to print borderless photos.

8. Select one of the following as the paper Type, depending on the paper you’re 
using:

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper

9. Select the photo size as the paper Size setting.

10. Click OK, then click OK or Print.

After your photos are printed, see “Removing Your Photos and Paper” on page 67.
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Macintosh OS 8.6 to 9.x

1. Open your photo file and resize it as necessary. 

2. Open the file menu and select Page Setup. You see this screen:

3. Select the photo size as the Paper Size.

4. Choose Roll Paper as the Paper Source.

5. Click Borderless if you want to print borderless photos.

6. Select one of the following Roll Paper Options:

■ Banner Mode: Makes multi-page documents print as one large page. When 
the Save roll paper option is checked, the printer stops printing after the last 
word or image is printed.

■ Cut Sheet Mode: Prints multi-page documents as individual pages. When 
the Print page frame option is checked, the printer prints a dashed line 
between each page.

7. Click OK.

8. Open the file menu and select Print.

9. Select one of the following as the Media Type, depending on the paper you’re 
using:

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper
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10. Select Quality (for higher print quality) or Speed (for faster printing) using the 
slider.

11. Click Print.

After your photos are printed, see “Removing Your Photos and Paper” on page 67.

Macintosh OS X

1. Open your photo file and resize it as necessary.

2. Open the File menu and select Page Setup. You see this screen:

3. Select Stylus Photo 900(Roll Paper) in the Format for drop-down list.

To print borderless photos, select Stylus Photo 900(Roll Paper - Borderless) 
or Stylus Photo 900(Roll Paper - Borderless Banner).

Caution: When printing photos on roll paper using a custom paper size, make 
sure the selected size is within the printable area for your printer. For example, 
never choose a size wider than 9 inches or longer than 44 inches.

4. Select the photo size as the Paper Size.

5. Click OK.

Select your printer 
name from the list
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6. Open the File menu and select Print.

7. Select Stylus Photo 900(Roll Paper) from the Printer drop-down list. 

If you selected a different Roll Paper option, make sure you select the same one as 
you chose in step 3.

Note: Make sure you chose the same printer that you selected in step 3.

8. Select Roll Paper Options from the drop down list. You see this window:

Select the same 
printer name you
chose in step 3
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9. Choose one of the following, depending on the Roll Paper setting you selected:

■ Banner Mode: Makes multi-page documents print as one large page. When 
the Save roll paper option is checked, the printer stops printing after the last 
word or image is printed.

■ Cut Sheet Mode: Prints multi-page documents as individual pages. When 
the Print page frame option is checked, the printer prints a dashed line 
between each page.

10. Select Print Settings from the list.

11. Select one of the following as the Media Type, depending on the paper you’re 
using:

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper

12. Select Quality (for higher print quality) or Speed (for faster printing) using the 
slider.

13. Click Print.

After your photos are printed, see “Removing Your Photos and Paper” on page 67.
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Removing Your Photos and Paper

After your photos are printed, you can either send another print job or cut off the 
photos and remove the paper from the printer.

1. Press the  roll paper button to print a cutting line. The printer feeds the paper 
to the cutting position.

2. Cut the paper along the dotted line, being careful not to pull the paper as you cut 
it.

3. When you’re finished printing on roll paper, you need to “unload it” from the 
printer. Press and hold the roll paper button for three seconds. The paper 
feeds backwards out of the printer.

You can also set the paper thickness lever to the manual feed position, then 
turn the knobs to roll up the paper. Make sure you return the lever to the 

position after you remove the paper.
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4. Turn the knobs to roll the rest of the paper onto the holder. Then press the 
roll paper button to turn off the red paper light.

5. Pull the roll paper holder out of its mounting slots and remove the roll paper from 
the holder.

6. Return the unused roll to its original package.

Store your printouts in resealable plastic bags, photo albums, or glass-covered picture 
frames. Keep both printed and unused roll paper away from high temperatures, 
humidity, and direct sunlight.
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Printing on Card Stock or Matte Board

You can use the manual feed slot in the back of the printer to print on white card 
stock or matte board up to 1.3 mm (0.051 inch or 51 mil) thick, in the following 
sizes: letter, legal, or A4 size.

Before you start, remove the paper support. Then turn the printer on. (The printer 
must be on to load card stock correctly.)

1. Push in the output tray extension, but leave the tray open.

2. Set the paper thickness lever to the  position. The  paper light begins flashing 
rapidly. 

3. Slide the edge guide to the right to make room for the card stock.
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4. Open the printer cover and place a sheet of card stock against the left side of the 
manual feed slot, with the side you want to print on facing up.

5. Slide the card stock into the printer until the leading edge is 1 cm (0.4 inches) 
from the gray rollers.

6. Slide the edge guide against the card stock.

1 cm

Printer rollers
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7. Set the paper thickness lever to the  position. (If the print quality is not 
satisfactory, try setting the paper thickness lever to the  position for the next 
print.)

If you’re using the manual feed slot to print on paper rather than card stock, set 
the paper thickness lever to the  position.

8. Close the printer cover and press the  button to feed the card stock into the 
printer.

Note: If the  paper light flashes, make sure the paper thickness lever is set 
correctly, then press the  button again.

9. Before you print, make sure you select Manual or Manual Feed as the paper 
source in your printer software (see “Printing in Windows” on page 21 or 
“Printing on a Macintosh” on page 31).

When you’re finished printing on card stock, make sure you return the paper 
thickness lever to the  position.

Caution: Don’t move the paper thickness lever during printing; this could damage 
your printer.
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Maintaining Your Printer

Follow the instructions in this chapter to keep your printer working at its best and to 
prepare it for moving, if necessary:

■ “Cleaning the Print Head” below

■ “Replacing an Ink Cartridge” on page 76

■ “Aligning the Print Head” on page 81

■ “Cleaning the Printer” on page 84

■ “Transporting the Printer” on page 85

For more details, see your on-screen User’s Guide.

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing, you may need to 
clean the print head. This unclogs the nozzles so they can deliver ink properly. Print 
head cleaning uses ink, so clean it only if quality declines.

This section explains how to clean the print head using the Head Cleaning utility. 

You can also clean the print head by holding down the  button on the printer for 
three seconds. (This only works when the red  light is off.)

Caution: When you don’t turn on your printer for a long time, print quality can 
decline, so turn it on and print a few pages at least once a month to maintain 
good print quality.
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Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red ink light is off. 
(If the ink light is flashing or on, you need to replace a cartridge; see page 76 
for details.)

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

Macintosh OS 8.6 to 9.x: Open the File menu and choose Page Setup or Print. 
Click the Utility button, then click the  Head Cleaning button.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select SP 900 in the printer list, click OK, and select Head Cleaning.

3. Follow the instructions on the screen to clean the print head. 

Cleaning takes about 45 seconds. The printer makes noise and the green 
power light flashes.

Caution: Never turn off the printer while the green power light is flashing, 
unless the printer hasn’t moved or made noise for more than 5 minutes.

4. When the green power light stops flashing, make sure paper is loaded in the 
printer, then do the following:

Windows: Click Print nozzle check pattern. Then click Print. 

Macintosh: Click Confirmation, then click Next.
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The nozzle check pattern prints (see “Examining the Nozzle Check Pattern” 
below for details).

5. If the nozzle check pattern has no gaps or white lines, click Finish.

If the pattern has white lines, click Clean to clean the print head again. 

If you don’t see any improvement after cleaning three or four times, refer to 
“Problems and Solutions” on page 94. 

You can also turn the printer off and wait overnight—this allows any dried ink to 
soften—and then try cleaning the print head again.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you printed. Each staggered line should be solid, 
with no gaps, as shown.

■ If your printout looks okay, you’re done.

■ If you see any gaps (as shown below), clean the print head again; see “Running the 
Head Cleaning Utility” on page 74 for instructions.
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Replacing an Ink Cartridge

■ When the red  ink light flashes, one or more ink cartridges are low on ink.

■ When the red  ink light stays on, you need to replace the cartridge(s).

When you print, you’ll also see a message on your screen telling you which cartridge is 
low or empty.

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if the red  ink light is off.

Checking the Ink Supply

To check your ink supply, do the following:

■ Windows: Double-click the  icon on the Windows taskbar. You see a window 
like this:

■ Macintosh OS 8.6 to 9.x: From the File menu, select Print, then click the  ink 
icon.

■ Macintosh OS X: Choose Applications > EPSON Printer Utility > SP 900 > 
Status Monitor.
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You see a window like this:

Purchasing Ink Cartridges

Use these EPSON ink cartridges within six months of installing them and before the 
expiration date on the package:

Caution: To ensure good results, use genuine EPSON ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered by 
EPSON’s warranty.

When you need new ink cartridges, contact your dealer, or call the EPSON Store at 
(800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call 
(800) 463-7766 for dealer referral.

Ink cartridge Part number

Black T007201

Color T009201

Click a cartridge image to 
display information about 
the cartridge.
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Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them thoroughly with water.

Caution: To avoid damaging the printer, never move the print head by hand.

You cannot print if an ink cartridge is empty. Even though you have a second 
black cartridge, you cannot print if one is empty. Leave the empty cartridge 
installed in the printer until you have obtained a replacement. Otherwise the ink 
remaining in the print head nozzles may dry out.

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session.

1. Make sure the printer is turned on (the green power light should be on, but 
not flashing). Then open the printer cover.

2. Press and release the ink button. The print head moves to the ink cartridge 
replacement position.
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The red  light also begins to flash or remains on.

■ If it flashes at the same speed as the green light, replace the black cartridge.

■ If it flashes twice as fast as the green light, replace the color ink cartridge.

■ If it remains on, replace both cartridges.

Note: You can also use the Status Monitor to find out which cartridge is out of 
ink. See “Checking the Ink Supply” on page 76 for more information.

The color cartridge is on the right and the black is on the left.

3. Pull up the ink cartridge clamp. The cartridge rises up from its holder.

4. Lift the cartridge out of the printer and dispose of it carefully.

5. Remove the new cartridge from its package. Then remove only the yellow tape seal 
on top.

Caution: Don’t touch the green circuit board on the back of the cartridge; you 
may inhibit normal operation and printing.
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6. Lower the new cartridge down into the holder.

Make sure the tabs rest on the hooks in back.

Caution: Don’t place the cartridge tabs under the hooks; you may damage the 
clamp when you close it.

7. Press down firmly on the ink cartridge clamp until it snaps in place.

8. If you need to replace the other ink cartridge, repeat steps 3 through 7 before 
continuing with step 9.

9. Close the printer cover and press the  ink button. The printer begins charging 
the ink delivery system.

Hooks
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The green power light flashes and the printer makes noise. Charging takes 
about half a minute. When it’s finished, the green power light stops flashing 
and stays on, and the red  light goes out.

Caution: Never turn off the printer while the green power light is flashing, 
unless the printer hasn’t moved or made noise for more than 5 minutes.

Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see light or dark horizontal 
banding, you may need to align the print head.

1. Turn on the printer.

2. Load several sheets of paper.

3. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Print Head Alignment.

Macintosh OS 8.6 to 9.x: From the File menu, select Page Setup or Print. Click 
the  Utility button, then click the  Print Head Alignment button.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select SP 900 in the printer list, click OK, and select Print Head 
Alignment.

4. Follow the instructions on the screen to print a test page. You see this window:
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5. On the test page, select the pattern with the two vertical lines most precisely 
printed on top of each other. You may need to use a magnifying glass or loupe.

Select one pattern each for rows 1 through 3. Enter the number of the best pattern 
for each row in the corresponding boxes on the screen. Then click Next.

If you can’t find an aligned pattern, choose the one that’s closest to being aligned. 
Then click Realignment to print another test page and repeat this step.

6. After you click Next, you see this window:

7. Click Print to print the first pattern on the next test page.
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8. After it prints, remove and reload the test page as shown, with pattern row #1 on 
the right.

9. Click Print again to print the second test pattern.

10. On the test page, select a box for columns 1 and 2 that does not contain any light 
or dark banding.
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11. Enter the number of the best looking box in each column in the corresponding 
boxes on the screen and click Finish.

If you can’t find a box that doesn’t contain banding, choose the one that looks the 
best. Then click Realignment to print another test page and repeat steps 6 
through 11.

Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year.

1. Turn off the printer, unplug the power cord, and disconnect the cable.

2. Remove all the paper, then use a soft brush to clean the sheet feeder.

3. If the outer case or inside of the sheet feeder is dirty, clean it with a soft cloth 
dampened with mild detergent. Keep the printer cover closed to prevent water 
from getting inside.
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4. If ink accidentally gets inside the printer, wipe it off with a damp cloth.

Warning: Don’t touch the gears or any other parts inside the printer.

Caution: Never use a hard or abrasive brush, or benzine, alcohol, or paint thinner 
for cleaning; they can damage the printer components and case.

Don’t get water on the printer components and don’t spray lubricants or oils 
inside the printer.

Transporting the Printer

If you need to ship your printer, you must prepare it for transportation in its original 
box or one of a similar size.

Caution: To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

1. Open the printer cover and turn on the printer. Wait until the print head locks in 
the far right position, then turn off the printer. 

2. Unplug the power cord from the electrical outlet. Then disconnect the printer 
cable from the printer.

3. Remove any paper from the printer, then remove the paper support and roll paper 
holders.

Clean here
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4. Open the printer cover. Secure the ink cartridge holder with the plastic insert that 
came with your printer (or secure it to the case with tape).

Caution: Be sure to remove the insert after installing the printer in its new 
location.

5. Close the printer cover, push in the output tray extension, then close the output 
tray.

6. Repack the printer and its attachments in the original box using the protective 
materials that came with them.

Keep the printer level as you transport it. 

After transporting the printer, remove the plastic insert or tape securing the print head 
and test your printer. If you notice a decline in print quality, clean the print head (see 
page 73); if output is misaligned, align the print head (see page 81).

Plastic insert



87

Installing Your Printer Software

Before you install your printer software, follow the steps on the Start Here sheet to set 
up your printer and connect it to your computer. 

If you’re using Windows XP, Windows 2000, Windows ME, Windows 98, or 
Macintosh OS X, follow the software installation instructions on the Start Here sheet.

If you’re using Macintosh OS 8.6 to 9.x, follow the instructions in this chapter to 
install your printer software.

Installing Printer Software on Macintosh 
OS 8.6 to 9.x

Before you start, make sure your printer is set up, connected to your computer, and 
turned on, as described on the Start Here sheet. Installation takes place in several 
phases. Follow the instructions in the two sections below, first to install your printer 
driver, and then to install additional software. 

Installing Your Printer Driver

1. Make sure your printer is connected and turned on. Then turn on your 
Macintosh.

2. Insert the EPSON CD-ROM in your CD-ROM or DVD drive.

3. Select the EPSON CD-ROM icon on your desktop, if necessary, then 
double-click the EPSON OS 8 and 9 Installer icon in the window that opens.

4. Read and agree to the license agreement to continue the installation.

5. Click Printer Driver and follow the instructions on the screen to install the 
software and restart your Macintosh.
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6. After your Macintosh restarts, register your printer with EPSON as instructed.

7. Open the Chooser from the Apple menu.

8. Select SP 900 and select your USB port.

9. Turn on background printing, then close the Chooser.

Follow the instructions in the next section to finish the installation.

Installing Optional Software

1. Double-click the EPSON CD-ROM icon then click the EPSON OS 8 and 9 
Installer icon in the window that opens.

2. Click EPSON Printer Information Center, then follow the instructions on the 
screen to install it on your desktop.

3. Click Photo Software and click the button for each program to learn more 
about it. If you want the program, click Install and follow the instructions on the 
screen. Then click Back to return to the Photo Software menu.

Note: If you see a message about installing QuickTime,® click Yes and follow the 
instructions on the screen. You don't need a registration number.

4. When you’re finished, close any open windows and click Back.

5. Click CD Printing Software, then follow the instructions on the screen to install 
EPSON Print CD.

6. Close any open windows and click Exit at the Install Menu.

7. Restart your computer if prompted. You’re ready to print.
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Solving Problems

See “Diagnosing Printer Problems” on page 91 to help determine what the cause of 
your printer problem may be. Then see these sections for solutions:

■ “Setup and Software Installation Problems” on page 94

■ “Printer Problems” on page 95

■ “Quality Problems” on page 96

■ “Paper Problems” on page 98

■ “CD/DVD Printing Problems” on page 99

■ “Miscellaneous Problems” on page 100

■ “Uninstalling and Reinstalling Printer Software” on page 102

■ “Where To Get Help” on page 103

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.
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Printer Parts

Roll paper button

Ink button Paper button

Power button

Paper support

Sheet feeder

Edge guide

Output tray

Output tray extension

Printer cover

Manual feed edge guide

Manual feed slot

Paper thickness 
lever

Parallel interface

USB interface

Roll paper holders
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Diagnosing Printer Problems

First, check the printer’s lights (see below) or run a printer check (see page 92).

Lights Explanation

Green power light 
flashes

The printer is receiving a print job, replacing an ink cartridge, 
charging ink, or cleaning the print head.

Red paper light on Your paper ran out. Load more paper and press the paper 
button.

Red paper light flashes Paper is jammed in the printer.

Press the paper button to eject the jammed paper. If the 
light is still flashing, open the cover and remove all paper, 
including any jammed or torn pieces. Then reload paper and 
press the paper button to continue printing. 

You can also set the paper thickness lever to the  position, 
pull the jammed paper out, then return the lever to the 

position.

If you’re using roll paper, press the  roll paper button. If the 
roll paper is jammed, you may need to remove the paper, then 
reload it to continue printing (see “Removing Your Photos and 
Paper” on page 67).

Red paper light flashes 
quickly

The paper thickness lever is set incorrectly.

Set the paper thickness lever to the correct setting for the 
paper that you loaded in the printer. See “Loading Paper” on 
page 13 for instructions.

Red ink light flashes One of the cartridges is low on ink. Check the message that 
appears on your screen to determine which cartridge is low or 
follow the instructions in “Checking the Ink Supply” on 
page 76. Make sure you have a replacement cartridge. 

Red ink light on One of the cartridges is out of ink or not installed. Make sure 
you have a replacement cartridge, then follow the steps in 
“Removing and Installing Ink Cartridges” on page 78 to install 
it.

If you have just installed a new cartridge, it may be 
incompatible with the printer or incorrectly installed. Reinstall it 
or replace it with the correct cartridge, as described page 78.

Green  power light and 
red ink light are on

One or both of the ink cartridges is not installed correctly. 
Reinstall it as described on page 78.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
or some other source. 

1. Turn off your printer and computer. 

2. Disconnect the printer’s interface cable.

3. Load letter-size paper in the printer.

4. Hold down the paper button, then press and release the power button. 
When printing starts, release both buttons.

A test page prints showing the printer’s ROM version number, an ink counter 
code, and a nozzle check pattern. (If the pattern has gaps, you need to clean the 
print head as described on page 73.)

Green  power light is off; 
red paper and red ink 
lights flashing alternately

Paper may be blocking movement of the print head. Turn off 
the printer, then open the cover and remove any jammed paper 
or other foreign objects. Turn the printer back on again. If the 
lights are still on, contact your dealer or EPSON as described in 
“Where To Get Help” on page 103.

Green  power light is off; 
red paper and red ink 
lights flashing

The printer may have an internal error. Turn off the printer, wait 
a few seconds, and turn it on again. If the lights are still 
flashing, contact your dealer or EPSON as described in “Where 
To Get Help” on page 103.

Lights Explanation
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■ If the test page prints, the problem probably lies in your software settings, 
interface cable, or computer, or your software may not be installed correctly.

■ If the test page doesn’t print, you may have a problem with your printer.

Try the suggestions in “Problems and Solutions” on page 94. If nothing works, 
contact your dealer or EPSON as described in “Where To Get Help” on 
page 103.

5. Turn off the printer, reconnect the interface cable, then turn on your printer and 
computer.
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Problems and Solutions

Setup and Software Installation Problems

The printer makes noise after ink 
cartridge installation.

■ When you install ink cartridges, 
the printer must charge its print 
head for a minute or so. Wait 
until it’s finished (the green 

power light stops flashing) 
before you turn off the printer, 
or it may use excess ink the next 
time you turn it on.

■ Make sure the ink cartridges are 
inserted completely and no 
packing material remains in the 
printer. Turn off the printer, 
wait a moment, then turn it 
back on.

You’re having problems installing 
the printer software.

■ Make sure your printer is turned 
on and its cable is securely 
connected at both ends. Follow 
the installation steps on the 
Start Here sheet or page 87 
(Mac OS 8.6 to 9.x), and make 
sure your system meets the 
requirements on page 105.

■ Close other programs, including 
screen savers and virus 
protectors, and install again.

■ If the SP 900 icon doesn’t 
appear in the Macintosh 
Chooser, you may have an 
extension conflict. Turn off any 
unnecessary extensions and 
restart.

■ If you see an error message with 
Windows 2000, you may not 
have software installation 
privileges. Contact your System 
Administrator.

■ If you’re using Windows and 
the USB port, make sure your 
system was not upgraded from 
Windows 95; the USB driver 
may not install correctly.

■ Make sure the USB Controller 
is working properly in Device 
Manager. See your Windows 
help system for details.

■ If you’re printing over a 
network, see “Setting Up 
Network Printing” in your 
on-screen User’s Guide for 
instructions on configuring your 
printer for use on a network.
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Printer Problems

Only the green power light is 
on, but nothing prints.

■ Make sure the interface cable is 
securely connected at both ends 
and meets the system 
requirements; see page 105.

■ Run a printer check as described 
on page 92. If the test page 
prints, make sure your software 
is installed correctly. 

■ If you’re printing on a network, 
make sure you set up your 
printer for network printing, as 
described in “Setting Up 
Network Printing” in your 
on-screen User’s Guide.

The printer sounds as though it is 
printing, but nothing prints.

■ The print head nozzles may 
need cleaning; see page 73 for 
instructions.

■ The printer won’t operate 
properly if it’s tilted or at an 
angle. Place it on a flat, stable 
surface.

Your printer makes noise when 
you turn it on or after it has been 
sitting for awhile.

Your printer is performing routine 
maintenance.

Printing is too slow.

Make sure your system meets the 
system requirements listed on 
page 105. If you’re printing a 
high-resolution image, you need 
more than the minimum 
requirements. You may also need to:

■ Clear space on your hard drive 
or run a defragmentation utility.

■ Close open programs that 
you’re not using.

■ Increase your system’s memory 
(RAM).

For the fastest printing, try these 
tips:

■ Select Draft as the Quality Type 
(Windows) or set the 
Quality/Speed slider to Speed 
(Macintosh).

■ In the Advanced window, turn 
High Speed on (Windows) or 
MicroWeave® off and High 
Speed on (Macintosh).

■ If your printer is connected to a 
USB hub, disconnect any 
unused USB devices.

■ If you’re using the parallel port, 
enable ECP/DMA mode on 
your computer’s parallel port. 
See your computer 
documentation or the 
manufacturer for instructions.
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Quality Problems

You see banding (light lines).

■ Clean the print head nozzles; see 
page 73 for instructions. 

■ Select a higher Quality Type or 
Print Quality and turn off High 
Speed mode; see “Printing in 
Windows” on page 21 or 
“Printing on a Macintosh” on 
page 31.

■ Make sure the paper Type 
(Windows) or Media Type 
(Macintosh) setting matches 
your paper; see page 27 
(Windows) or page 42 
(Macintosh) for guidelines.

■ Make sure the printable side of 
the paper is face up.

■ The ink cartridges may need 
replacing; see page 76.

■ Try using Automatic mode 
(Macintosh only); See “Printing 
on a Macintosh” on page 31 for 
instructions.

■ Align the print head as 
described on page 81.

■ Make sure Maximum 
(Windows), Minimize 
Margins (Macintosh 8.6 to 
9.x), or Stylus Photo 
900(Standard - Minimize 
Margins) (Macintosh OS X) is 
not selected. Banding may occur 
in the expanded area.

Your print is blurry or smeared.

■ Make sure your paper isn’t 
damp, curled, or loaded face 
down.

■ Use a support sheet with special 
paper, or try loading your paper 
one sheet at a time.

■ Make sure your paper meets the 
specifications listed in the 
on-screen User’s Guide. 
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■ Use EPSON papers for proper 
saturation and ink absorption. 

■ Check the paper thickness lever. 
Set it to for most papers and 

 for envelopes; for CDs or 
DVDs, see page 53 or for heavy 
stock, see page 69.

■ Align the print head as 
described on page 81.

Your printout is faint or has gaps.

■ Clean the print head nozzles; see 
page 73 for instructions. 

■ The ink cartridges may be old or 
low on ink; see “Checking the 
Ink Supply” on page 76. 

■ Make sure the paper Type 
(Windows) or Media Type 
(Macintosh) setting matches 
your paper; see page 27 
(Windows) or page 42 
(Macintosh) for guidelines.

■ Make sure your paper isn’t 
damaged, old, dirty, or loaded 
face down. If it is, load new 
paper, face up. For best results, 
use genuine EPSON paper.

Your printout is grainy.

■ Use a higher quality paper or 
select a higher Quality Type or 
Print Quality setting; see 
“Printing in Windows” on 
page 21 or “Printing on a 
Macintosh” on page 31.

■ Align the print head as 
described on page 81.

■ Increase the image resolution or 
print it in a smaller size; see your 
software documentation.

You see wrong or missing colors.

■ Make sure Black ink only is off 
(Windows) or Color Ink is 
selected (Macintosh), even for 
black and white photographs.

■ Clean the print head nozzles; see 
page 73 for instructions. 

■ The ink cartridges may be old or 
low on ink; see “Checking the 
Ink Supply” on page 76.

■ Try turning off PhotoEnhance.™ 
Also check if you’re using a 
special effect that alters image 
colors, like Sepia.
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■ Try using Automatic mode 
(Macintosh only). See “Printing 
on a Macintosh” on page 31 for 
instructions.

■ Try changing the Gamma 
setting. See “Customizing 
Windows Print Settings” on 
page 25 or “Customizing 
Macintosh Print Settings” on 
page 38 to access the Advanced 
settings.

■ Your printed colors can never 
exactly match your on-screen 
colors. However, you can use a 
color management system—
such as ICM (Windows) or 
ColorSync (Macintosh)—to get 
as close as possible. See 
“Customizing Windows Print 
Settings” on page 25 or 
“Customizing Macintosh Print 
Settings” on page 38 for details.

Paper Problems

Paper doesn’t eject fully or is 
wrinkled.

■ If the paper doesn’t eject fully, 
you may have set the wrong 
paper size. Press the paper 
button to eject the paper, then 
select the correct paper size.

■ If it’s wrinkled when it ejects, 
the paper may be damp or too 
thin. Load new paper.

Paper sheets don’t feed correctly 
or jam in the printer.

■ If paper doesn’t feed or multiple 
pages feed, remove it from the 
sheet feeder. Fan the edges of 
the sheets, reload them against 
the right side of the feeder, and 
slide the edge guide snugly, but 
not too tightly, against the 
paper. Don’t load paper above 
the arrow on the left edge guide.

■ If paper jams, press the paper 
button. If necessary, open the 
cover and remove any jammed 
or torn pieces. Load new paper 
and press the paper button. 

You can also set the paper 
thickness lever to the  
position, pull out the jammed 
paper, and then return the lever 
to the position.

Card stock doesn’t feed correctly 
or jams in the printer.

Follow the steps in “Printing on 
Card Stock or Matte Board” on 
page 69 to use the manual feed slot.
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Roll paper doesn’t feed correctly 
or jams in the printer.

■ Cut the end of the paper 
straight across. If it’s cut 
diagonally, the paper won’t feed 
smoothly.

■ If the roll paper end is curled, 
place the end inside a folded 
sheet of paper and roll it 
backwards against the curl.

■ As you load the paper, gently 
hold it in the roll paper feeder 
with your hand; don’t force the 
paper into the feeder.

■ Select Roll or Roll Paper as the 
Source or Paper Source in your 
print settings. If you select 
another setting, too much paper 
will feed. 

■ If extra paper feeds, press the 
roll paper button for three 

seconds to rewind the paper 
(repeat if necessary to back it all 
the way out). If the paper 
light is on, press the paper 
button to turn it off. Reload the 
paper as described in “Loading 
Roll Paper” on page 14.

CD/DVD Printing 
Problems

Images and text are not centered 
on the CD/DVD.

Adjust the print position as 
described in “Adjusting the Print 
Position” on page 57.

Ink smears on the CD/DVD or 
printing is too light.

Adjust the print density as described 
in “Adjusting the Print Density” on 
page 59. You can also adjust the 
brightness or contrast, as described 
in “Designing CDs and DVDs” on 
page 49.

Make sure you’re using ink-jet 
printable CDs.

Printed CDs or DVDs are dirty.

Clean the roller as described in 
“Cleaning the Roller” on page 48.

The paper light flashes quickly.

Make sure the paper thickness lever 
is set to the position; see 
“Inserting a CD or DVD” on 
page 53.
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Miscellaneous 
Problems

The image is inverted, as if viewed 
in a mirror.

Turn off Mirror Image or Flip 
Horizontal in the printer software 
or the mirror setting in your 
program. See “Customizing 
Windows Print Settings” on 
page 25 or “Customizing 
Macintosh Print Settings” on 
page 38 to access Advanced settings. 

The printer prints blank pages.

■ Make sure your printer is 
selected in the Print window 
(Windows), is the active printer 
in the Chooser (Macintosh OS 
8.6 to 9.x), or is selected in the 
Format for drop-down list on 
the Page Setup window and 
Printer drop-down list on the 
Print window (Macintosh 
OS X).

■ Clean the print head nozzles; see 
“Cleaning the Print Head” on 
page 73 for instructions.

You see incorrect characters.

■ Make sure the interface cable is 
securely connected at both ends 
and meets the system 
requirements on page 105.

■ Make sure your printer is 
selected in the Print window 
(Windows), is the active printer 
in the Chooser (Macintosh OS 
8.6 to 9.x), or is selected in the 
Format for drop-down list on 
the Page Setup window and 
Printer drop-down list on the 
Print window (Macintosh 
OS X).

■ If you’re using a switch box or 
USB hub with your printer, 
connect the printer directly to 
your computer instead.

The margins are incorrect.

■ Make sure the paper settings are 
correct for your paper size. See 
“Printing in Windows” on 
page 21 or “Printing on a 
Macintosh” on page 31.

■ Choose the correct margins for 
your paper size. The margins 
must be within the printable 
area of the page; see “Printable 
Area” in your on-screen User’s 
Guide.

■ If you’re using Macintosh OS X 
make sure you choose the same 
printer in the Page setup 
window and the Print window.

■ Place your paper against the 
right side of the sheet feeder 
with the edge guide snug against 
it.
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■ If you’re using the manual feed 
slot, make sure the card stock is 
loaded as described on page 69.

■ Make sure the Borderless 
option is set correctly for your 
margins; see page 28 or page 43 
or “Printing on Roll Paper” on 
page 61.

Too many copies are printing.

Make sure that the Copies option in 
your printer software or program is 
not set for multiple copies.

Image size/position is incorrect.

■ Make sure the paper and layout 
options are set correctly.

■ If you’re using Macintosh OS X 
make sure you choose the same 
printer in the Page setup 
window and the Print window.
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Uninstalling and Reinstalling Printer 
Software

You may need to uninstall then reinstall your printer driver and utilities if, for 
example, you upgrade your Windows operating system. You don’t need to uninstall 
your other photo software, CD printing software, or the EPSON Printer Information 
Center.

Windows

1. Click Start, and select Programs or All Programs.

2. Point to Epson or EPSON Printers, then select EPSON Printer Software 
Uninstall.

3. In the next window, select EPSON Stylus Photo 900 and click OK. Then follow 
the on-screen instructions.

4. Restart your computer, then see the Start Here sheet to reinstall your software.

Note: If you uninstall the EPSON Printer Software or P.I.M. II Plug-In, the ICC 
color profiles are also uninstalled. You must reinstall the profiles from the 
CD-ROM.

Macintosh OS 8.6 to 9.x

1. Insert your printer software CD-ROM.

2. Double-click EPSON on your desktop, then double-click EPSON in the folder 
that opens. The Install Menu appears.

3. Click Install Printer Driver, then click Continue. On the Installer screen, click 
the arrow in the Easy install list at the top and select Uninstall. Then click the 
Uninstall button at the bottom and follow the instructions.

4. Restart your Macintosh, then see the “Installing Your Printer Software” on 
page 87 to reinstall your software.
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Macintosh OS X

1. Open the Applications folder, then the Utilities folder.

2. Select Print Center, hold down the  key and select all items labeled Stylus 
Photo 900, then click the Delete button.

3. Restart your Macintosh, then see the Start Here sheet to reinstall your software.

Where To Get Help

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed below:

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7282, 6 AM to 8 PM, Pacific Time, Monday through Friday and 
7 AM to 4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply. 

Please have the following information ready:

■ Product name (EPSON Stylus Photo 900)

■ Product serial number (located on the back of the printer and on its box)

■ Proof of purchase (such as a store receipt) and date of purchase

Service Access

World Wide 
Web

From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download drivers and 
other files, look at product documentation, access troubleshooting 
information, and receive technical advice through e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, seven 
days a week. To use these services, you must have a touch tone 
telephone and call (800) 922-8911. Your EPSON SoundAdviceSM 
Express Code is 70455. Use this code to quickly select the EPSON 
Stylus Photo 900 in SoundAdvice.
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■ Computer configuration and operating system version

■ Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the EPSON 
Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, 
please call (800) 463-7766 for dealer referral.
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Windows System Requirements

To use your printer and its software, your system should have:

■ A Microsoft Windows compatible PC with a Pentium® II 266 MHz processor or better

■ Microsoft Windows 98, Me, 2000, or XP

■ 128MB or more of RAM recommended

■ 200MB or more free hard disk space recommended

■ VGA or better display adapter and monitor

■ CD-ROM or DVD drive for installing the printer software

■ USB connection: a Windows-compliant USB port and a shielded USB “AB” cable, up to 6.5 feet 
(2 meters) long

Parallel connection: a high-speed, bidirectional, IEEE-1284 compliant parallel cable (6 to 10 feet 
long) with a D-SUB, 25-pin, male connector (computer end) and a 36-pin Centronics® 
compatible connector (printer end)

Macintosh System Requirements

To use your printer and its software, your system should have:

■ An Apple® iMac™ or eMac™ series, Power Macintosh® G3 or G4, PowerBook,® or iBook™

■ Mac OS 8.6 through 9.x, or OS X 10.1.x to 10.2.x (certain features not supported) 

■ 128MB or more of available RAM recommended (256MB or more recommended for Mac OS X)

■ 200MB or more of free hard disk space recommended

■ VGA display or better

■ CD-ROM or DVD drive for installing the printer software

■ A shielded USB “AB” cable, up to 6.5 feet (2 meters) long
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Important Safety Instructions

Before using your printer, read these safety instructions to make sure you use it safely and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.
Placez l’imprimante près d’une prise de courant où la fiche peut être débranchée facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the outlet’s ampere rating.

■ Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation, leaving at least 3.9 inches 
between the back of the printer and the wall.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

■ When transporting or storing the printer, don’t tilt it, stand it on its side, or turn it upside-down. 
This may allow ink to leak from the ink cartridges.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.

Caution: Always turn the printer off using the  power button. Don’t switch off the power 
strip or unplug the printer until the green  power light is off.

■ Do not block or cover the openings in the printer’s case or insert objects through the slots. 

■ Except as specifically explained in this manual, do not attempt to service the printer yourself. 

■ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change 
in performance. Adjust only those controls that are covered by the operating instructions.
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Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

■ Do not put your hand inside the printer or touch a cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge 
unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use 
up the ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ Store ink cartridges with the bottom of the packaging facing down.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

■ Do not shake an ink cartridge after removing it from its package; this can cause leakage.

■ Do not remove or tear the label on an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

■ Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and 
printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

■ Before transporting the printer, make sure the print head is capped in the far right position and the 
ink cartridges are in place. Secure the ink cartridge holder with the included plastic insert to make 
sure it remains in the proper position.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which exceed the 
limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a 
shielded equipment interface cable with this device. If this equipment has more than one interface 
connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly 
approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON

Type of Product: Ink Jet Printer

Model: B211A

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this product 
meets the ENERGY STAR guidelines for energy efficiency. The EPA 
ENERGY STAR office equipment program is a voluntary partnership with 
the computer and office equipment industry to promote the introduction 
of energy-efficient personal computers, monitors, printers, fax machines, 
and copiers in an effort to reduce air pollution caused by power 
generation.
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Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“EPSON”) warrants to the first retail purchaser that the 
EPSON printer covered by this limited warranty statement, if purchased and used in the United States 
or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship 
and materials for a period of one (1) year from the date of original purchase. EPSON also warrants that 
the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified 
usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. 
For warranty service, you must provide proof of the date of original purchase.

What EPSON Will Do To Correct Problems: Should your EPSON printer prove defective during the 
warranty period, please call the EPSON Connection  at (562) 276-7282 (U.S.) or (905) 709-2567 
(Canada) for warranty repair instructions and return authorization. An EPSON service technician will 
provide telephone diagnostic service to determine whether the printer requires service. If service is 
needed, EPSON will, at its option, exchange or repair the printer without charge for parts or labor. If 
EPSON authorizes an exchange for the defective unit, EPSON will ship a replacement printer to you, 
freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit and returning it to EPSON within five (5) working days of receipt of the 
replacement. EPSON requires a debit or a credit card number to secure the cost of the replacement 
printer in the event that you fail to return the defective one. If your printer is being repaired, EPSON 
will direct you to send your printer to EPSON or its authorized service center, where the printer will be 
fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the 
EPSON authorized service center. When warranty service involves the exchange of the printer or a 
part, the item replaced becomes EPSON property. The replacement printer or part may be new or 
refurbished to the EPSON standard of quality, and, at EPSON’s option, may be another model of like 
kind and quality. EPSON’s liability for replacement of the covered printer will not exceed the original 
retail selling price of the covered printer. Exchange products and parts assume the remaining warranty 
period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and 
Canada. This warranty is not transferable and will not apply to products purchased from an end user. 
This warranty does not cover any color change or fading of prints or reimbursement of materials or 
services required for reprinting. This warranty does not cover damage to the EPSON product caused 
by parts or supplies not manufactured, distributed or certified by EPSON. This warranty does not 
cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the 
EPSON product after its shipment from EPSON, e.g., dealer or user-added boards or components. 
EPSON is not responsible for warranty service should the EPSON label or logo or the rating label or 
serial number be removed or should the product fail to be properly maintained or fail to function 
properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused 
by disasters such as fire, flood, and lightning, improper electrical current, software problems, 
interaction with non-EPSON products, or service other than by an EPSON Authorized Servicer. If a 
claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

SM
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THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE 
BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL 
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE 
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH 
OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and 
you may have other rights which vary from jurisdiction to jurisdiction. 

Epson America, Inc. ■  P. O. Box 93012 ■  Long Beach, CA 90809-3012
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Index

A

Accessories, ordering, 104
Adobe Photoshop, P.I.M II plug-in for, 8
Advanced settings

Macintosh, 38 to 41
Windows, 25 to 26

Aligning print head, 81 to 84
Animations

Print Show, 8
Animations, Print Show, 10 to 11
Automatic mode

Macintosh OS 8.6 to 9.x, 32 to 33
Macintosh OS X, 36

B

Background printing, 33 to 34
Banding, 96
Basic printing

Macintosh OS 8.6 to 9.x, 32 to 34
Macintosh OS X, 35 to 37
Windows, 22 to 24

Blank pages, 100
Blurry images, 96 to 97
Borderless printing

Windows, 28 to 29
Bright White Paper, 19, 27, 42
Browser, 10
Buttons, 90 to 92

C

Cable, printer, 105
Cancelling printing

Macintosh OS 8.6 to 9.x, 34
Macintosh OS X, 37
Windows, 24

Card stock, printing on, 69 to 71
CDs

adjusting print density, 59 to 60
adjusting print position, 57 to 59
designing, 49 to 52
inserting in printer, 53 to 56
ordering, 47
printing on, 47 to 60
printing problems, 99

Characters, incorrect, 100
Checking printer, 92 to 93
Chooser, Macintosh, 32, 88, 100
Cleaning

print head, 73 to 75
printer, 84
roller, 48

Color management
menu, Macintosh OS X, 41
settings, 25, 39

Color problems, 97
ColorLife Photo Paper, 19, 27, 42
ColorSync, 37, 38, 40, 98
Control panel, 90 to 92
Controlling printing

Macintosh OS 8.6 to 9.x, 34
Macintosh OS X, 37
Windows, 24

Custom settings
Macintosh, 38 to 41
Windows, 25 to 26
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D

Declaration of Conformity, 109
Default settings, Windows, 24
Documentation, 9 to 11
Double-Sided Matte Paper, 19, 27, 42

E

ECP/DMA mode, 95
Electronic manual, 9 to 11
Energy Star compliance, 109
Envelopes, 17 to 18
EPSON

accessories, 104
Film Factory, 8
help, 103 to 104
Monitor IV, 34
papers, 19, 27, 42
PhotoCenter, 8
Print CD, 8, 49 to 52, 56 to 60
Printer Information Center, 8, 10 to 11
SoundAdvice, 103
store, 77, 104
warranty, 110 to 111

F

Faint images, 97
FCC Compliance Statement, 108
Features, 7
Film Factory, 8
Format for setting, Macintosh OS X, 35

G

Gamma setting, 25
Gamma settings, 39
Glossy Photo Paper, 19, 27, 28, 29, 42, 43, 44, 

46
Grainy prints, 97
Greeting Cards, Glossy Photo, 19, 27, 42

H

Head Cleaning utility, 74 to 75
Heavy stock, printing on, 69 to 71
Help

EPSON, 103 to 104
High Speed setting, 95, 96

I

ICM (Image Color Management) setting, 25, 
98

Incorrect
characters, 100
colors, 97
margins, 100

Ink cartridge
level of ink in, 24, 33, 76 to 77
ordering, 77
problems, solving, 91, 94
replacing, 76 to 81
safety instructions, 78, 107

Ink Jet Transparencies, 19, 27, 42
Ink level, checking

Macintosh, 33, 76 to 77
Windows, 24, 76

Ink setting
Macintosh OS 8.6 to 9.x, 33
Macintosh OS X, 36
problems, solving, 97

Installation problems, 94
Installing software, 87 to 88
Iron-On Transfer Paper, 19, 27, 42

J

Jams, paper, 91 to 92, 98
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L

Layout problems, 101
Layout settings

Macintosh OS 8.6 to 9.x, 33
Macintosh OS X, 37
Windows, 26

Letterhead, 14
Lights, 91 to 92
Luster Photo Paper, 14, 19, 27, 28, 29, 42, 43, 

44, 46, 62, 63, 66

M

Macintosh
basic printing, OS 8.6 to 9.x, 32 to 34
basic printing, OS X, 35 to 37
Chooser, 32, 88, 100
system requirements, 105
uninstalling software, 102 to 103

Maintaining printer, 73 to 86
Manual feed slot, 53 to 56, 69 to 71, 98
Margins, incorrect, 100
Matte board, printing on, 69 to 71
Matte Paper Heavyweight, 19, 27, 42
Matte Paper, Double-Sided, 19, 27, 42
Media Type setting

envelopes, 18
Macintosh OS 8.6 to 9.x, 33
Macintosh OS X, 36
selecting correct, 42

MicroWeave setting, 95
Monitor IV, 34
Monitoring ink level

Macintosh, 33, 76 to 77
Windows, 24, 76

Moving printer, 85 to 86

N

Network printing, 94
Noise, printer, 94, 95
Nozzle Check, 92 to 93

O

Orientation setting
envelopes, 18
Macintosh OS 8.6 to 9.x, 44
Macintosh OS X, 45
Windows, 23, 29

P

Page Setup, Macintosh, 32, 35
Paper

EPSON, 19, 27, 42
feeding problems, 98
heavy stock, 69 to 71
loading in manual feed slot, 69 to 71
loading in sheet feeder, 13 to 14, 28, 43
thick, 69 to 71
thickness lever, 18, 53 to 56, 69 to 71

Paper Size setting
envelopes, 18
Macintosh OS 8.6 to 9.x, 32
Macintosh OS X, 35
roll paper, 62, 63, 64
Windows, 23, 29

Paper Source setting
CDs and DVDs, 56
heavy stock, 71
Macintosh OS 8.6 to 9.x, 32, 44
roll paper, 62, 63
Windows, 29

Paper thickness lever, 18, 53 to 56, 69 to 71
Paper Type setting

selecting correct, 27
selecting in Windows, 23

Parallel cable, 105
Photo Quality Glossy Paper, 27, 42
Photo Quality Ink Jet Cards, 19, 27, 42
Photo Quality Ink Jet Paper, 19, 27, 42
Photo software, 8
Photo Stickers, 19, 27, 42
PhotoCenter, EPSON, 8
PhotoEnhance, 97
Photographs, displaying and storing, 20
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Premium Bright White Paper, 19, 27, 42
Premium Glossy Photo Paper, 19, 27, 42
Premium Luster Photo Paper, 19, 27, 42
Premium Semigloss Photo Paper, 19, 27, 42
Preprinted paper, 14
Previewing printout, 33
Print CD software, 8, 49 to 52, 56 to 60
Print Center, Macintosh OS X, 35, 37
Print head

aligning, 81 to 84
cleaning, 73 to 75

Print Head Alignment utility, 81 to 84
PRINT Image Matching

description, 8
Print Image Matching

plug-in for Photoshop, 8
Print position check disk, 57 to 59
Print Quality

problems, 96 to 98
settings, 23, 39, 41

Print Settings menu, Macintosh OS X, 36
Print Show animations, 10 to 11
Print window, 22
Printer

cable, 105
check, 92 to 93
cleaning, 84
control panel, 90 to 92
maintaining, 73 to 86
noise, 94, 95
parts, 90
problems, 91 to 101
transporting, 85 to 86

Printer Information Center, 8, 10 to 11
Printing

advanced, 25 to 26, 38 to 41
CDs and DVDs, 47 to 60
controlling, 24, 34, 37
Macintosh OS 8.6 to 9.x, basic, 32 to 34
Macintosh OS X, basic, 35 to 37
Windows, basic, 22 to 24
with custom settings, Macintosh, 38 to 41
with custom settings, Windows, 25 to 26

Problems
CD/DVD printing, 99
diagnosing, 91 to 93
installing software, 94
miscellaneous, 100 to 101
paper feeding, 98 to 99
print quality, 96 to 98
solving, 89 to 104

Properties window, 23

Q

Quality Type setting, 23
Quality/Speed setting

Macintosh OS 8.6 to 9.x, 33
Macintosh OS X, 36

R

Reinstalling software, 102 to 103
Roll paper

button, 17, 67, 90
holders, 14, 16, 90
loading, 14 to 17
printing on, 61 to 68
problems, solving, 99
removing, 67 to 68
storing, 68

S

Safety instructions, 106 to 107
Self Adhesive Sheets, 19, 27, 42
Semigloss Photo Paper, 19, 27, 42
Service, 103 to 104
Sheet feeder

loading envelopes in, 17 to 18
loading paper in, 13 to 14, 28, 43
problems, solving, 91, 98

Slow printing, 95
Smeared printout, 96, 99
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Software
installation problems, solving, 94
installing, 87 to 88
photo, 8
Print CD, 8, 49 to 52, 56 to 60
reinstalling, 102 to 103
uninstalling, 102 to 103

SoundAdvice, 103
Stickers, 19, 27, 42
Support, 103 to 104
System requirements, 105

T

Technical support, 103 to 104
Testing printer, 92 to 93
Thick paper, 69 to 71, 98
Thickness lever, paper, 18, 53 to 56, 69 to 71
Transfer paper, 19, 27, 42
Transparencies, 19, 27, 42
Transporting printer, 85 to 86
Troubleshooting, 89 to 104
Tutorials, Print Show, 10 to 11
Type setting, 23

U

Uninstalling software, 102 to 103
USB, 94, 95, 105
User’s Guide, 8, 11
Utilities

Head Cleaning, 74 to 75
Nozzle Check, 74 to 75
Print Head Alignment, 81 to 84

W

Warranty, 110 to 111
Watermark, 26, 33
Windows

basic printing, 22 to 24
default settings, 24
system requirements, 105
uninstalling software, 102
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EPSON Ink Jet Papers and Ink Cartridges

Use EPSON® paper and inks to get the same photo quality results that have earned EPSON’s printers 
all of their awards! EPSON papers are specially coated to work with EPSON genuine inks. Here are 
details about just a few of EPSON’s papers, your printer’s ink cartridges, and EPSON project ideas:

Premium Glossy Photo Paper

Water-resistant, photographic-weight paper with a high gloss 
finish. Perfect for all photographic applications and available in a 
variety of cut-sheet and roll paper sizes. Framing is 
recommended for this paper type.

Premium Semigloss Photo Paper

With its 10-mil thickness and soft gloss finish, this instant drying paper has the 
appearance of a traditional photograph. Offering vibrant colors and rich blacks, it 
delivers outstanding image quality and is ideal for all color photographic 
applications. Available in both 4-inch rolls and letter-size cut sheets.

Matte Paper Heavyweight

Heavyweight, bright white, ultra-smooth coated paper with a matte finish. Perfect 
for enlargements and framing of cherished photographs.

EPSON Ink Cartridges 

For best results, always use genuine EPSON ink cartridges.

Black T007201
Color T009201

For more information on other EPSON products and fun project ideas, look 
for the EPSON Print Lab  Series at www.printlabseries.com.

See the inside back cover for a list of EPSON papers and ink cartridges, and ordering information.

SM
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How To Order EPSON Ink and Paper

To order EPSON ink cartridges, paper, and other printing media, contact your dealer or 
call the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). 
In Canada, please call (800) 463-7766 for dealer referral.

EPSON Ink Cartridges

EPSON Papers

* Availability of paper types varies by location. Make sure you select the correct setting before you print.

Ink Cartridge Part number

Black T007201

Color T009201

Paper name* Size Part number

EPSON Premium Bright White Paper Letter (8.5 x 11 inches) S041586

EPSON Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

A4 (8.3 x 11.7 inches) S041061

Legal (8.5 x 14 inches) S041067

EPSON Photo Paper or EPSON Glossy Photo Paper Letter (8.5 x 11 inches) S041141/S041272/
S041271/S041649

A4 (8.3 x 11.7 inches) S041140

Panoramic (8.3 x 23 inches) S041145

EPSON ColorLife Photo Paper Letter (8.5 x 11 inches) S041500

EPSON Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

EPSON Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257

EPSON Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041286/S041667

4 x 6 inches, borderless S041682

5 x 7 inches, borderless S041464

4 inches x 26 feet (roll) S041302

8.3 inches x 32.8 feet (roll) S041376

EPSON Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

4 inches x 26 feet (roll) S041329

EPSON Premium Luster Photo Paper Letter (8.5 x 11 inches) S041405 

8.3 inches x 32.8 feet (roll) S041408

EPSON Ink Jet Transparencies Letter (8.5 x 11 inches) S041064

EPSON Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106

EPSON Iron-On Transfer Paper Letter (8.5 x 11 inches) S041153/S041155

EPSON Glossy Photo Greeting Cards Letter (8.5 x 11 inches); perforated edges S041606

EPSON Photo Stickers Kit (CD-ROM/stickers)
EPSON Photo Stickers (refill)

A6 (4.1 x 5.8 inches)
A6 (4.1 x 5.8 inches)

S041144-KIT
S041144
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